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P
Photo art, referred to today as “photo paint-
ing,” will always be a sought-after art form, just 
accomplished differently according to what’s 
available in a particular time period. Never in 
history has so much been available as right 
now! In the following pages, we’ll show you 
how to transform a photograph into a work 
of art using Photoshop CS2 and Painter IX 
together with a Wacom Intuos 3 tablet. 
 Imagine taking a paintbrush, dipping it 
into the photograph, and then blending the 
pixels—the result is magical. Every pixel in the 
photograph is transformed into a brush stroke, 
making the final outcome a beautiful paint-
ing. Come along with me as we explore the 
wonderful world of photo painting. 
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Fay Sirkis is an internationally recognized portrait artist, photographer, and instructor based in New York. A beta 
tester for Corel Painter, Fay’s work is featured in Corel’s Painter Masters Art Gallery. Her commissioned portraits 
and paintings are held in private collections internationally and exhibited in museums and art galleries. To see 
more of Fay’s work, check out www.faysartstudio.com.

Examples of photo painting

Painted version

 Original Painted version
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The process begins by bringing an image into Photoshop where 
we’ll do all the color adjustments, retouching, and cropping, 
then we’ll bring it into Painter IX, where we’ll add paint over the 
photograph and begin to blend the paint daubs together with 
the pixels using various brushes. 
[NAPP members may go to www.photoshopuser.com/members/
magcenter/2005.php to read more about using Adobe Photoshop 
with Painter IX to transform a photo into a painting.]
 Here’s where the magic begins: Close your eyes for a second 
and imagine yourself in front of a real canvas with traditional oil 
paints all around. You can almost smell the turpentine…. With 
that image firmly in your mind, slowly open your eyes and forget 
that you’re sitting in front of a computer. Reach for your brush 
(21st century stylus pen) and start painting. When I can envision 
myself in a traditional environment, I can paint freely as I did in 
BC—before computers!

 Watercolor or oil?
After choosing your image, you need to decide a couple  
of things before starting to paint; for example, should you 
paint the image as an oil painting or watercolor? So, what 
determines the style of painting? It’s the style and the over- 
all key (light or dark) of your painting, and most important, 
what type of media you’ll be printing on when your painting 
is finished. 
 For this feature, I chose the image of Ashlie in an evening 
gown—Classy Ashlie—photographed with a dark background, 
which I chose to leave in (see page 41). Because of the way she’s 
dressed, I decided to paint her in virtual oil, painting edge to 
edge with no white border, and with a final output on canvas.

Color mode, resolution, and file size
The next issue to decide is what size your final painting will be. 
Whatever the original size of your original image, change it to 
the size that you want your painting’s final output size to be. 
Note: If it’s larger than 16x20", I recommend increasing the size 
after you’re finished the painting, because of memory issues.  
If you’re printing on an inkjet printer, keep your color mode  
as RGB at a resolution of 300 ppi.
 Now that we have all the technical stuff out of the way,  
let’s paint!

Color-correct your image
The first thing you almost always have to do is color-correct 
the image. Open your original image in Photoshop, resize it 
(Image>Image Size) and set the Resolution at 300 ppi, then 
change the image mode to RGB and save it as “name01” (in our 
example Ashley01) as a PSD file. This new file will serve as your 
base image. Close your original image. Note: Saving your work 
using sequential numbers helps to identify successive versions 
of the painted image, and you can clone information from any 
previous save, if needed. 039

STEP ONE: Create a duplicate of the Background layer (Com-
mand-J [PC-Control J]) and rename the layer “retouched.”

STEP TWO: There are 
many ways to color-cor-
rect but for now let’s 
use a simple Levels 
adjustment. Click on the 
Retouched layer in the 
Layers palette and press 
Command-L (PC-Con-
trol-L) to bring up the 
Levels dialog. Drag the top-right highlight slider left to the start 
of the histogram and click OK. This brightens the image and gets 
rid of the color cast. 

STEP THREE: With the retouched layer active, 
choose the Spot Healing Brush (new in Photoshop 
CS2) from the Toolbox. This brush analyzes the 
area around the tool as you use it and automati-
cally samples the best pixels to use for healing the 
selected area. Click once on a blemish or click-and-
drag to smooth away blemishes or wrinkles in a 
larger area. 
 Make sure the Proximity Match button is clicked 
on in the Options Bar. Using a soft-edged brush 
that’s slightly larger than the 
area you want to fix (so that 
you can cover the entire area 
with one click), just paint 
right over the blemish. It 
will appear to be painting in 
black until you let go of the 
brush and then the blemish 
will miraculously disap-
pear—no sampling with the 
Option (PC: Alt) key required! 
 Do all the retouching that’s necessary on the retouched 
layer—for example, stray hair, spots on the image, or any other 
imperfections that you don’t want in your painting— before 
going on to the next step.

 Add soul to the eyes
To bring life to the eyes, you must add light. In some portraits, 
the eyes are represented by two dark circles without any 
definition in the iris or pupil. It’s important to show separation 
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between the pupil, the iris (the colored portion of the eye sur-
rounding the pupil), and the dark ring around the iris. When you 
show separation, the eyes take on depth. Here’s how to retouch 
the eyes in our image. Note: Use the Zoom tool (Z) to see the 
finer details. 

STEP ONE: Make a copy of the retouched layer by dragging it to 
the Create a New Layer icon at the bottom of the Layers palette. 
Double-click on the layer’s name and rename it “Iris color.”

STEP TWO: Select the Dodge tool (O) and up in the Options Bar, 
set Range to Midtones and Exposure to no more than 15%. Use a 
small, soft-edged brush to lighten the color of the iris.
 Now make a copy of the Iris color layer and rename it “Ring 
around the Iris.” We’ll use the Burn tool set to Midtones and a 
50% Exposure to darken the circle around the iris. 
 Continuing on this layer, use the same Burn tool to make  
sure the pupil is solid, dark, and nicely rounded.
 Now with the Burn tool and a very small brush, darken the 
eyebrows and eyelashes. Darken one eyelash at a time and  
follow the direction and sweep of the hair.

STEP THREE: Create a new blank layer and name it “Catch Light.” 
There should be only one catch light in each eye—usually at 
10 o’clock or 2 o’clock, depending on where the light’s coming 
from. With a small brush, paint a white dot on the edge of the 
pupil, and then lower the layer opacity so that it’s not too sharp. 
Note: If you have more than one catch light in each eye, use the 
Clone Stamp tool (S) to paint it out with the color of the pupil. 

STEP FOUR: Add another new blank layer named “Moon High-
lights.” With a small soft-edged brush, paint a crescent-shaped 
highlight in the iris of the eye. Lighten the side of the iris op-
posite the catch light—the highlight color should be the same 
color as the iris, but almost white at its lightest form. 

STEP FIVE: Create a blank 
layer named “Whites 
of Eyes.” The white 
shouldn’t be pure white 
but some shade of cream 
color (plus a few blood 
vessels). Sometimes 
part of the white is in 
shadow, like the corners 
of the eyes, so choose 
a soft brush and paint 
in the areas that should 
be white, and decrease 
the layer Opacity slider 
until the whites look 
right. Don’t eliminate the 
blood vessels completely 
because it takes away 
from a natural look. 

 Add a blur to the face
One last step before we bring the image into Painter is to add  
a little blur to the face to give us a head start on the skin blend-
ing. New to Photoshop CS2 is Surface Blur, which really does 
the trick! It softens the skin, giving the face that dreamy look, 
without the haziness that the Gaussian Blur gives. 

STEP ONE: We’ll merge all of the layers except the Background 
layer, so in the Layers palette, click on its Eye icon to hide it. 
Then click on the Layers palette flyout arrow (at the top right  
of the palette), choose Merge Visible, and name the merged 
layer “Retouched eyes.”
 Duplicate the Retouched eyes layer and rename it  
“Face Blur.” 

STEP TWO: Draw a loose 
selection around the face 
and apply a Surface Blur 
(Filter>Blur>Surface Blur) 
to the selected area. In the 
dialog, set the Radius to 50 
and Threshold to 10. Press 
Command-D (PC: Control-D) 
to deselect. 
 If this is too much blur, 
lower the layer Opacity. We 
don’t want to overdo the 
blur; just a little help so that we don’t have too much noise and 
texture in the face when we begin to blend it in Painter.
 Now add a Layer Mask (click on the circle-in-a-square icon at 
the bottom of the Layers palette) and use the pressure-sensitive 
brush (stylus pen) to paint away any Blur that’s been applied 
in areas such as the eyes and mouth. We want to maintain the 
surface blur on the cheeks, forehead, and chin.  

STEP THREE: Make sure you save a version of the file with all 
of the layers before you flatten the image—so you can make 
changes later, if necessary. Name this layered version “Classy 
Ashlie 02.”
 Now flatten all of the layers in the image down to the Back-
ground layer (from the layer flyout menu, choose Flatten Image). 
Let’s call this flattened version “Classy Ashlie 03.” 
 Close the image in Photoshop and bring it into Corel Painter IX. 
Now the fun begins!

Cloning in Painter
The first thing you should always do is Clone your document so 
that your original is there to fall back on. 

STEP ONE: Select File>Open and choose the file you want to 
Clone (in our case, the retouched image Classy Ashlie 03). This 
will be our Source, which must remain open while you work in 
the Clone. Always work on the Clone document; never work on 
the original. 

Reprinted by permission of the National Association of Photoshop Professionals ( )
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STEP TWO: Now choose File>Clone (not Quick Clone) and Painter 
creates a Clone of the source document in its own window, with 
the words “Clone of” preceding the source document’s name in 
the Title Bar. (Note: If your original image has layers, cloning cre-
ates a fully composite copy and all of the layers in the cloned copy 
are automatically dropped.)

STEP THREE: Save the cloned copy of your image as a PSD file 
and rename it as “Classy Ashlie 04.”

 Adding a Layer 
When you open your 
document in Painter, your 
image appears on a layer 
known as the Canvas layer 
(similar to what we know 
as the Background layer in 
Photoshop). As you add 
more layers to a document, 
this allows you to manipu-
late the visual elements in 
the image independently 
of the Canvas. 

Open your Classy 
Ashlie 04 image  
in Painter then  
open the Layers  
palette. Create a 
new layer by click-
ing on the third 
button from the  
left at the bottom  
of the Layers palette. 
This adds a layer 
above your Canvas 
layer, which we’ll 
rename “Painting.”
Note: It’s important 
to check the Pick  
Up Underlying  
Color box in the  
Layers palette. This 
will merge colors 
from the photo  
with the colors  
that you’ll be  
applying to your 
new layer (once 
we start blending 
them), without 
affecting the image 
on the Canvas.

 Apply paints and start blending
The next step is to choose a brush from the more than 30 brush 
categories, ranging from Crayons, Chalk, and Charcoal to Acryl-
ics, Watercolor, Artists Oils, and Liquid Ink. The brush Selector 
Bar lets you choose from a variety of brush categories and vari-
ants. At the top of the Bar is the brush category with the variant 
appearing underneath. Brush categories are groups of similar 
brushes and media, while brush variants are specific brushes 
and brush settings within a brush category; for example, in  
the Oils category, there are Bristle Oils, Fine Camel, and Flat  
Oil variants. 

To choose a Brush, first click the Brush Category and choose  
a Brush; then click the Brush Variant and choose a Variant.

Transform a

into a

Brush categories Brush variants
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Blending brushes
One of the strongest features of Painter is its amazing blending 
engine. Not only can you blend the paints that you apply to the 
canvas, you can also blend the paints with the pixels. Most of the 
Painter brushes apply different styles of paint media in limitless 
colors to the image. 
 Blender brushes, however, don’t apply paint; instead, they 
make changes to the paint that’s already in the image. The 
brushes under the Blenders category affect underlying pixels 
by moving and mixing them. Using a Blender brush on a blank 
area of the canvas has no effect: You must use it on an area 
with information.
 Equally important as to what colors and styles of paint we use 
is what we paint with and how we apply and blend the paints. In 
the traditional world, I painted with very expensive brushes. So 
why should digital painting be any different? It’s not: I like to use 
more than one stylus pen on a Wacom 3 Intuos tablet. It’s the 
only choice for me because the stylus pen behaves and feels just 
like a paintbrush—allowing you to simulate your unique draw-
ing and painting style. The more I work as I did traditionally, the 
more productive I can be.

How to choose color
You can select colors in several ways, such as using the: 
• Color squares on the Colors palette
• Dropper tool, which samples color from the image
• Use Clone Color setting, which pulls color from a source
• Mixer palette
• Color Sets palette

To display the Colors 
palette, choose Window> 
Color Palettes>Show 
Colors. By default, the 
Colors palette displays in 
its standard configuration, 
which includes the Hue 
Ring and the Satura-
tion/Value Triangle. Values 
span the triangle from top to 
bottom, with the top of the 
triangle being the highest 
value (white) and the bottom 
being the lowest value (black). 
Saturation levels go from left 
to right. Dragging to the right 
produces the purest color 
within the predominant hue. 
Dragging to the left reduces 
the level of color saturation, 
producing grayer colors.

Painting the face
Choose an area where you want to start painting. I usually 
start with the face because it’s the most important and the 
hardest to paint. I start by painting in the foundation (just  
like makeup) and then at the end, I’ll come back and add  
the finishing touches.

STEP ONE: Start by blending the pixels on the Painting layer  
that we created earlier Note: Always remember to check Pick  
up Underlying Color in the Layers palette.

STEP TWO: Choose Grainy Water from the Blenders brush  
category and work with a small brush in short circular strokes  
(if you don’t, you’ll see nothing but a schmeer). 
 For the highlights in the face, first add color with the Digital 
Airbrush from the Airbrush category and then blend it very 
softly using the Grainy Water variant and a small brush. For a 
little more texture (if it gets too smeary or flat) add more paint 
with Artist Pastel Chalk from the Pastels category. 
 Another great brush for adding color to faces is Charcoal/
Soft Charcoal. Option-click (PC: Alt-click) in the highlight areas 
to sample the color you’ll paint with. Always go a little lighter 
than you sampled so that when you blend the paint, you’ll 
have more depth.

STEP THREE: Use the same brushes for the shadows. Try  
to bring in colors that are lighter and darker than the color  
you sampled—again, for depth. Note: When you sample- 
click a color in Painter, it samples only one pixel at a time  
unlike Photoshop where you have a choice of sampling  
from a larger area.

Painting the hair
Hair requires brushes with more “bristles.” Apply paint using 
Chunky Oil Pastel 10 from the Oil Pastel category. Chalk adds 
nice texture to hair as well. For blending in the hair and the  
paint you’ve applied to it, use Smeary Bristle Spray from the  
Oils category, set to 0% Resat. 
 When you have a value of 0% Resat (in the Property Bar, 
which is docked horizontally below the Menu Bar), it auto- 
matically makes the brush a Blending brush, which will blend  
the paints in the shape of the brush, in this case, with Bristles— 
perfect for blending hair!
 Medium Bristle Oil from the Oil category is another great 
brush for adding color as well as for blending. 

Clothing
Clothing requires many different brushes and blenders.  
It depends on the type of clothing you’re painting and the  
look you’re after. If it’s high-texture, then use a lot of chalks;  
if it’s a soft look that you want to create, then go with Oils  
and Airbrushes.

Color palette wheel

Color Mixer
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The digital Manicure
It’s sometimes necessary to do things for our clients that are 
above and beyond… For example, it seems that this beautiful 
young lady didn’t have time to do her nails before the portrait 
sitting—Painter to the rescue!

STEP ONE: We can choose a color from the Color wheel for her 
nail polish; or we can press Option (PC: Alt) on the color of the 
existing polish, which is what we did to fix it. Apply the polish 
with the Digital Airbrush (we want it to look like polish not paint 
and this brush softly lays down the color).

STEP TWO: Blend in the polish gently with the Grainy Water  
variant in the Blenders category.
 If nail “filing” is necessary, use Grainy Water to gently file 
around the nail. Keep blending until you get the desired shape. 

(In the real world it’s better to file the nails and then apply the 
polish…but hey, this is digital and we can do whatever we want!)

STEP THREE: Add white highlights on the side curves of the nails 
and blend them in to give the nails a nice shine. To finish it off, 
paint a white line on the edge of the nails to simulate the look of 
a nice “French manicure.”

Final color adjustments and output
Once we’re finished painting, bring the file back into Photoshop, 
where we’ll do all of the final adjustments. For example, I almost 
always have to do a Levels adjustment again before the final 
printing, because the slightest color shift occurs when you paint 
(we spoke about this earlier). 
 All my watercolor portraits are printed on beautiful acid-
free, textured fine art paper and each print has a special matte 
coating designed for high-quality, fine art reproductions. I print 
on the Epson 9600 directly from Photoshop, using inks that are 
“guaranteed to last 100 years under normal lighting conditions.” 
It’s highly recommended that you use UV museum glass or UV 
Plexiglas to preserve the beauty of your painting.
 On oil portraits, there are two ways you can prepare the final 
output: Print directly on the canvas with your inkjet printer or 
give your file to a lab to print out your painting on photographic 
paper. If you have it mounted on canvas board at your lab of 
choice, you’ll get much sharper detail, especially in the shadow 
area (although I do all my printing in-house). Here’s my final 
painted image of Classy Ashlie. ■  

Before Painted Classy Ashlie
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